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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Curiosity HPC Development Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity HPC Development Board as a 
development tool to emulate and debug firmware on a target board. The document is 
organized as follows:
• Chapter 1. “Introduction to Curiosity High Pin Count (HPC)” – This chapter 

contains general information regarding the Curiosity HPC Development Board kit 
contents, layout and power source.

• Chapter 2. “Getting Started” – This chapter offers information on how to 
program the Curiosity HPC Development Board.

• Chapter 3. “Troubleshooting” – Consult this chapter for troubleshooting 
information.

• Appendix A. “Schematic” – This appendix lists the Curiosity HPC Development 
Board schematic.

• Appendix B. “General Notes” – Refer to this appendix for general notes on 
using the Click module sockets and the solder blob jumpers.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions:

DOCUMENT CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the Curiosity HPC Development Board. For the 
latest information on using other tools, refer to the MPLAB® X IDE home page: 
www.microchip.com/mplabx/. This resource page contains updated documentation, 
downloads and links to other MPLAB X compatible tools, plug-ins and much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes, sample programs 
and labs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software
Curiosity Development Board-specific product support can be accessed via our 
website at www.microchip.com/curiosity.

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.

http://www.microchip.com
http://www.microchip.com
http://www.microchip.com/curiosity
http://www.microchip.com/curiosity
http://www.microchip.com/pagehandler/en-us/family/mplabx/home.html
http://www.microchip.com/pagehandler/en-us/family/mplabx/home.html
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the website at: 

www.microchip.com/support.

REVISION HISTORY

Revision A (July 2016)

Initial release of this document.

http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx
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Chapter 1.  Introduction to Curiosity High Pin Count (HPC) 

The Curiosity High Pin Count (HPC) Development Board supports Microchip’s 28- and 
40-pin 8-bit PIC® MCUs. Two unique PDIP sockets are surrounded by dual-row 
expansion headers, which allow for connectivity to all pins on the PIC MCUs. 
Programming/debugging is accomplished through the PICkit™ On Board (PKOB), 
eliminating the need for an external programming/debugging tool. The development 
board includes a set of four indication LEDs, a potentiometer, and push-button 
switches. Additionally, the Curiosity HPC Board integrates two MikroElektronika 
microBUS™ sockets, which accommodate a variety of plug-in Click™ Board modules 
that can be used for application development.

1.1 CURIOSITY HIGH PIN COUNT (HPC) DEVELOPMENT BOARD KIT 
CONTENTS

The Curiosity High Pin Count (HPC) Development Board kit contains the following: 

• Curiosity High Pin Count (HPC) Development Board 

• Quick Start Guide

• PIC16F18875 MCU
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FIGURE 1-1: HPC DEVELOPMENT BOARD

1

2
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891011

1. USB micro connector
2. 3.3/5V power jumper
3. Master Clear Reset button
4. Dual-row expansion headers
5. PIC  MCU socket for 28-pin microcontroller
6. PIC  MCU socket for 40-pin microcontroller
7. mikroBUS  Click Board socket 1
8. mikroBUS  Click Board socket 2
9. Push button SW2
10. Push button SW1
11. Potentiometer
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Chapter 2.  Getting Started

The Curiosity HPC Development Board can be used with either MPLAB® X Integrated 
Development Environment (IDE, version 3.0 or higher) or MPLAB® Xpress IDE; both 
IDEs are available for free at www.microchip.com. 

The Curiosity HPC Development Board contains a PICkit On Board (PKOB) which 
allows for both low-voltage programming and low-voltage in-circuit debugging for all 
supported devices. When used with the MPLAB IDE, in-circuit debugging allows the 
user to run, modify, and troubleshoot their custom software and hardware quickly, 
without the need for additional debugging tools.

2.1 PROGRAMMING THE CURIOSITY HPC DEVELOPMENT BOARD

Programming the Curiosity HPC Development Board can be accomplished through 
one of the two following ways: either through MPLAB X (version 3.30 or higher), or 
through MPLAB Xpress.

2.1.1 Programming Using MPLAB® X

1. Connect the Curiosity HPC Board to the computer using the on-board micro-USB 
connector.

2. Open MPLAB X and either create a new project or open an existing one.

3. Click on the Project Properties icon located in the project’s Dashboard window 
(as seen in Figure 2-1). Alternatively, the Project Properties window can be 
opened by clicking on File > Project Properties, or by right-clicking on the project 
name in the Projects window and clicking Properties.

Note: The Curiosity HPC Board must be programmed using Low-Voltage 
Programming (LVP). The LVP bit of the Configuration Word(s) must be set 
(LVP = ON or ‘1’).


www.microchip.com

www.microchip.com
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FIGURE 2-1: PROJECT PROPERTIES BUTTON

4. The Project Properties window will open. This window allows for the selection of 
the programming tool, compiler, and PIC MCU. MPLAB X refers to the Curiosity 
HPC Board as ‘Starter Kits (PKOB)’, with ‘Curiosity’ listed below in the Hardware 
Tool selection window. Click on Curiosity to select the Curiosity HPC Board, 
then click the Apply button (as seen in Figure 2-2).
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FIGURE 2-2: SELECTING THE CURIOSITY HPC DEVELOPMENT BOARD 

5. In the upper left-hand corner of the Project Properties window, click on Starter 
Kits (PKOB). The window will now show the configuration options for the PKOB 
programmer, as shown in Figure 2-3.

FIGURE 2-3: PROGRAM OPTIONS FOR THE PICkit™ ON BOARD (PKOB)
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6. In the Option categories drop-down menu, select Program Options; ensure that 
the Enable Low Voltage Programming checkbox is checked (Figure 2-4). This 
option should go default to checked, which ensures low-voltage programming. 
Click the OK button. The Curiosity HPC Board is now ready to be programmed.

FIGURE 2-4: ENSURE LOW-VOLTAGE PROGRAMMING IS ENABLED

7. Once the project is ready to be programmed, simply click on the Make and 
Program Device button, and MPLAB will build and compile the code and 
program the PIC device, as displayed in Figure 2-5.

FIGURE 2-5: DEVICE PROGRAMMING
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2.1.2 Programming using MPLAB® Xpress

1. Connect the Curiosity HPC Board to the computer using the on-board micro-USB 
connector.

2. Type the link to the MPLAB Xpress IDE (www.mplabxpress.microchip.com) into 
a browser window. 

3. Create a new project or open an existing project.

4. At the very bottom of the MPLAB Xpress window, click on the label USB Bridge 
Disconnected (Figure 2-6); a new Manage USB Bridge window will open.

FIGURE 2-6:  CONNECTING THE USB BRIDGE


www.mplabxpress.microchip.com
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5. The new window configures the USB connection between the computer and the 
Curiosity HPC Board (Figure 2-7). Step 1 indicates that the latest Java Runtime 
Environment must be installed, allowing the user to download and install the 
latest version. Step 2 opens the bridge tool; click on the Download USB Bridge 
Tool button to download the bridge tool. A new window, MPLAB Xpress USB 
Bridge will appear, and may ask for the unique token found in Step 3 in the 
Manage USB Bridge window. Copy and paste the token into the USB Bridge tool. 
Once connected, the Bridge tool will show the connection and the words 
“Everything is looking good.” will appear (Figure 2-8). It is important to note that 
the Bridge Tool window must remain open while working on the project. Click the 
OK button in the Manage USB Bridge window.

FIGURE 2-7:  MANAGE USB BRIDGE WINDOW 

FIGURE 2-8:  MPLAB® Xpress USB BRIDGE WINDOW
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6. Click on the Project Properties icon located in the project’s Dashboard window 
(Figure 2-9). Alternatively, the Project Properties window can be opened by 
clicking on File > Project Properties, or by right-clicking on the project name in 
the Projects window and clicking Project Properties.

FIGURE 2-9: SELECTING THE CURIOSITY HPC IN MPLAB® Xpress 

7. The Project Properties window will open; this window allows for the selection of 
the programming tool, compiler, and PIC MCU. MPLAB Xpress refers to the 
Curiosity HPC Board as ‘Curiosity’, with the Curiosity HPC serial number listed 
below in the Hardware Tool selection window. Click on the serial number to 
select the Curiosity HPC Board then click the Apply button (Figure 2-10).
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FIGURE 2-10: SELECTING THE CURIOSITY HPC IN MPLAB® Xpress 

8. In the upper left-hand corner of the Project Properties window, click on Starter 
Kit (PKOB). The window will now show the program options for the PKOB. 
Ensure that the Enable Low-Voltage Programming checkbox is checked 
(Figure 2-11) and press the OK button. The Curiosity HPC Board is now ready to 
be programmed.

FIGURE 2-11: ENSURING LOW-VOLTAGE PROGRAMMING IS ENABLED 
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9. Once the project is ready to be programmed, simply click on the Make and 
Program Device button and MPLAB Xpress will build and compile the code, and 
program the PIC device (Figure 2-12).

FIGURE 2-12: PIC® DEVICE PROGRAMMING 
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Chapter 3.  Troubleshooting

This chapter discusses common operational issues and methods to resolve them.

3.1 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity HPC Development Board’s PICkit On Board (PKOB) uses low-voltage 
programming. Both MPLAB X and MPLAB Xpress set the Low-Voltage Programming 
(LVP) bit to a ‘1’, allowing low-voltage programming. 

1. When using custom firmware, the LVP bit must be set to ‘1’ in the Configuration 
Word. MPLAB X will not allow programming using the PKOB unless the bit is 
properly configured.

2. When using a PIC microcontroller (one not included with the Curiosity 
Development Board) that has already been programmed using high-voltage 
programming and the LVP bit is cleared (LVP = OFF or ‘0’), the device will not be 
recognized and cannot be programmed using the PKOB. Reprogramming the 
device can be achieved by one of the following two methods:

a) Connect a PICkit™ 3 Programmer to the PIC device dual-row expansion 
headers, ensuring the appropriate ICSP™, GND, and VDD connections are 
made. Configure MPLAB to use the PICkit 3 as the programmer, and ensure 
the LVP bit is set to ‘1’ in the Configuration Word. Reprogram the device.

b) Use an unprogrammed (blank) device and ensure the LVP bit is set to ‘1’ in 
the Configuration Word.
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Appendix A. Schematic

A.1 CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC

FIGURE A-1: CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC (1 OF 2)

��

��

��

��

��

��

�
�

	
	






�
�

��
�

��

�
��
��
���
	

�
�� ��

��
��

��
��

��
��

��
��

��
�

��
��

��
��

��
��

��
�

�

��
�

��
���

 �!
�

��
��

"�
�

#�
��

$ 
!�

�
%

�&
 �

 
'�

��
��

�


��
��
��
�

��
��

�
�#

(
'�


)
�

�
��*

+
��

��
��

���
 �!

�
,

 -
�



.

��
#'

/�
�#

�0
��

��
1	

�1'
��

��
#�

�

2'
0 

'�
��

�
�

���
�#

��
�

��
��

��
��

�
� 

3�



�
�

��
��

��
�#

��4
5,

6�
��

�
!� 

5,
��

,

�
�
�

�
�
�
�

�
�
	
�
�

�
�

�


�
�
��

�
�

�
�

	
�

�
�

�
�

	
�

%2
�

�
��- �7�
�

�- �7�
�

�- �7�
�

�- �7�
��

�- �7�
�

��
-

�7�
�

��
-

�7�
�

� � � 8 � 9 �� ������������ �8� � � �9�� ��
�������������8���9���������������8���9��

��
�

� � � 8 � 9 ��

�� ��
��������

�8

� � �

�9 �����������������8��
�� %

2�
��

	*
%

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
8

%2
�

%2
�

%2
�

:
�

�
:

��

%	
�

%	
�

%	
�

%	
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
8

%	
�

%	
�

�;
�%

	�
%;

�%
	8:
��

:
�

�
%


�
%


�
%


�
%


�
%


�
%


�
%


��
�<

	
%


8�
�<

�

%
2�

��
	*

%
%�

�
%�

�
%�

�
%�

�
%�

�
%�

�

%�
�

%�
8

:
��

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

�;
�%

	�
%;

�%
	8:
��

:
�

�
%


�
%


�
%


�
%


�
%


�
%


�
%


��
�<

	
%


8�
�<

�

��
%<

2�
��

1	
��

��
��

1�

��
%<

2�
��

1	
��

��
��

1�
�:

.
�


�:
�

�=
*�

2%

*

=

�

>.
�

�2
%�

%2
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%2
�

%2
�

%2
�

%�
�

%�
8

%	
�

%	
�

%	
�

%	
�

%�
�

%�
�

%�
�

%�
�

%	
�

%	
�

%	
�

%	
8

%�
�

%�
�

%�
�

%�
8

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

8

%�
�

%�
�

%�
�

%�
�

%�
8

�-
�7

�
��

�-
�7

�
��

%	
�

%�
�

�

	�
�

�	
?

�

�
1�

=
�

�
=

�1
�

@�
��

:
8

<
4

�
�

�A
�

��

14
�

��

%;
��

�;
��

�	
*

��

��
�

��

@�
:

��

<
4

�
9

�
4

�

,
 -

�



.
�

��
�

%�
�

�

	�
�

�	
?

�

�
1�

=
�

�
=

�1
�

@�
��

:
8

<
4

�
�

�A
�

��

14
�

��

%;
��

�;
��

�	
*

��
��

�
��

@�
:

��
<

4
�

9

�
4

�

,
 -

�



.
�

��
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
8

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
8

%2
�

%2
�

%2
�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%	
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
�

%�
8

%

�

%

8

%

�

%

8

%	
�

%	
8

%	
�

%	
8

%2
�

%2
�

�:
�

�:
.

�


%2
�

�
�

%2
�

�
�

%2
�

�
�

%�
�

%	
�

�
�

>�

�
�

>�

�
�

>�

�
�

>�

�
�

>�

�
�

>�

�
�

>8

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
8

�
�

>�
�

�
�

>�
9

%�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

%�
�

%�
�

%

�

%

�

%

�

%

�

%

�

%

�

%�
�

%�
�

%

�

%	
�

%	
�

%	
8

%	
�

%	
�

%	
�

%	
�

%	
�

�=
*�

2%

*

=

�

>.
�

�2
%�

�=
*�

2%

*

=

�

>.
�

�2
%�

�
�
�
�
�
�
8
�

�
4

�
>�

�

�
�
�
�
�
�
8
�

�
4

�
>�

�

�
�
�
�
�
�
8
�

�
4

�
>�

�

�
�
�
�
�
�
8
�

�
4

�
>�

8

�:
� �:

�
�:

.
�


�:
.

�


�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
8

�
�

>�
�

�
�

>�
9

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

>�
�

�
�

�
�

�
�

8
�

9
��

��
��

��
��

��
��

�8
��

�9
�� ��

�� ��
��

��
��

�8
��

�9
��

��
��

��
��

��
�� �� ��

�8 �9

��
%2

�
%�

�
%�

�
%�

�
%�

�
%�

�
%�

�
%2

�
%2

�
%2

�

%�
�

%�
8

%	
�

%	
�

%	
�

%	
�

%�
�

%�
�

%�
�

%�
�

%	
�

%	
�

%	
�

%	
8

%�
�

%�
�

%�
�

%�
8

%

�

%

�

%

�

%

�

%

�

%

�

%

�

%

8

��
�5

$
��

:

�
��

��
�5

$
��

:

�
��

�5
$

�
��

�5
$

�
��

�:
�

�

�
�

�
4

�

��
�8

��
?

B
3

C
�

�:
.

�
 �:
�

�
=

�
.

*2
��

�
=

�
.

*2
��

%

�

�:
�

�
�:

�
�

�:
�

�
�:

�
�

�:
�

�
�:

�
�

�:
�

� �:
�

�
�:

�
�

�:
�

�
�:

�
�

�:
�

�

�:
�

�
�:

�
�

�
4

�
	

��
�

4
�

	
��

��
��

��
��

��
�%

%
�9

��
�%

%
��

��
�%

%
��

��
�%

%
��

�
� �

��
-

�
�

�
�

�
�

�
�

8
�

9
��

��
��

��
��

��
��

�8
��

�9
�� ��

�� ��
��

��
��

�8
��

�9
��

��
��

��
��

��
�� �� ��

�8 �9

��
�

%2
�

�
4

�

�:


*
?

�
4

�

<
4

�


*
?

�
4

�

��
9


*
?

�
4

�

��
��

%2
�

�
4

�

�:
�

�

%2
�

�
4

�

�:
�

%�
�

%

�



DS40001856A-page 26  2016 Microchip Technology Inc.

Curiosity High Pin Count Development Board User’s Guide

FIGURE A-2: CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC (2 OF 2)
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Appendix B. General Notes

B.1 microBUS™ CLICKS

Module 1 is the main click socket, which is compatible with both 28-pin and 40-pin PIC 
devices. Module 2 is the secondary socket, and is fully compatible with a 40-pin PIC 
device. When using a 28-pin PIC device, Module 2 may be used with some Click 
modules, as long as the application does not use the SPI Chip Select (CS) line, the 
Reset (RST) line, or the PWM line dedicated to Module 2.

B.2 SOLDER BLOB JUMPER

Solder blob jumpers can be found on each Click module, push-button switch, LED, or 
potentiometer connection. This allows the user to utilize those pin connections for other 
applications.
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Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon

Hong Kong
Tel: 852-2943-5100
Fax: 852-2401-3431

Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

China - Beijing
Tel: 86-10-8569-7000 
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Chongqing
Tel: 86-23-8980-9588
Fax: 86-23-8980-9500

China - Dongguan
Tel: 86-769-8702-9880 

China - Guangzhou
Tel: 86-20-8755-8029 

China - Hangzhou
Tel: 86-571-8792-8115 
Fax: 86-571-8792-8116

China - Hong Kong SAR
Tel: 852-2943-5100 
Fax: 852-2401-3431

China - Nanjing
Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

China - Qingdao
Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533 
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8864-2200 
Fax: 86-755-8203-1760

China - Wuhan
Tel: 86-27-5980-5300
Fax: 86-27-5980-5118

China - Xian
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

ASIA/PACIFIC
China - Xiamen
Tel: 86-592-2388138 
Fax: 86-592-2388130

China - Zhuhai
Tel: 86-756-3210040 
Fax: 86-756-3210049

India - Bangalore
Tel: 91-80-3090-4444 
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-3019-1500

Japan - Osaka
Tel: 81-6-6152-7160 
Fax: 81-6-6152-9310

Japan - Tokyo
Tel: 81-3-6880- 3770 
Fax: 81-3-6880-3771

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul
Tel: 82-2-554-7200
Fax: 82-2-558-5932 or 
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068

Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069

Singapore
Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-213-7828

Taiwan - Taipei
Tel: 886-2-2508-8600 
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE
Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829

France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79

Germany - Dusseldorf
Tel: 49-2129-3766400

Germany - Karlsruhe
Tel: 49-721-625370

Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44

Italy - Milan 
Tel: 39-0331-742611 
Fax: 39-0331-466781

Italy - Venice
Tel: 39-049-7625286 

Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340

Poland - Warsaw
Tel: 48-22-3325737 

Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

Sweden - Stockholm
Tel: 46-8-5090-4654

UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820
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Океан Электроники
Поставка электронных компонентов 

Компания «Океан Электроники» предлагает заключение долгосрочных отношений при 

поставках импортных электронных компонентов на взаимовыгодных условиях! 

Компания «Океан Электроники» является официальным дистрибьютором и эксклюзивным 
представителем в России одного из крупнейших производителей разъемов военного и 
аэрокосмического назначения «JONHON», а так же официальным дистрибьютором и 
эксклюзивным представителем в России производителя высокотехнологичных и надежных 
решений для передачи СВЧ сигналов «FORSTAR». 

Наши преимущества: 

- Поставка оригинальных импортных электронных компонентов напрямую с производств Америки, 
Европы и Азии, а так же с крупнейших складов мира; 
- Широкая линейка поставок активных и пассивных импортных электронных компонентов (более 
30 млн. наименований); 
- Поставка сложных, дефицитных, либо снятых с производства позиций; 
- Оперативные сроки поставки под заказ (от 5 рабочих дней); 
- Экспресс доставка в любую точку России; 
- Помощь Конструкторского Отдела и консультации квалифицированных инженеров; 
- Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов;  
- Поставка электронных компонентов под контролем ВП; 
- Система менеджмента качества сертифицирована по Международному стандарту ISO 9001; 
- При необходимости вся продукция военного и аэрокосмического назначения проходит 
испытания и сертификацию в лаборатории (по согласованию с заказчиком);
- Поставка специализированных компонентов военного и аэрокосмического уровня качества 
(Xilinx, Altera, Analog Devices, Intersil, Interpoint, Microsemi, Actel, Aeroflex, Peregrine, VPT, Syfer, 
Eurofarad, Texas Instruments, MS Kennedy, Miteq, Cobham, E2V, MA-COM, Hittite, Mini-Circuits, 
General Dynamics  и др.); 

«JONHON» (основан в 1970 г.)

Разъемы специального, военного и аэрокосмического 
назначения: 
(Применяются в военной, авиационной, аэрокосмической, 
морской, железнодорожной, горно- и нефтедобывающей 
отраслях промышленности) 

«FORSTAR» (основан в 1998 г.) 

ВЧ соединители, коаксиальные кабели, 
кабельные сборки и микроволновые компоненты: 

(Применяются в телекоммуникациях гражданского и 
специального назначения, в средствах связи, РЛС, а так же 
военной, авиационной и аэрокосмической отраслях 
промышленности). 

Телефон:    8 (812) 309-75-97 (многоканальный) 
Факс:           8 (812) 320-03-32 
Электронная почта:    ocean@oceanchips.ru 
Web:      http://oceanchips.ru/ 
Адрес:   198099, г. Санкт-Петербург, ул. Калинина, д. 2, корп. 4, лит. А


